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Agenda

• Know your audience - Tailor your story to who's listening
• Foundation first - Clean data structure principles
• Visual perception - How our brains decode information
• Chart encyclopedia - Choosing the right visualization for your story
• Design principles - Creating compelling information experiences
• Ethics matter - Responsibility and truth in visual communication
• Tools of the trade - From Excel to advanced platforms
• From principles to practice - Building your expertise

2
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Why Data Visualizations Matters
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Faster decision-making 
Spot trends and outliers quickly in any dataset. 1

Clear communication 
Present complex information in an accessible format2

Team alignment 

Ensure everyone interprets data consistently 
3

Quality assurance 
Visual patterns reveal data issues and anomalies4



Leading the way to better careLeading the way to better careNorthwestern University Feinberg School of Medicine

Know Your Audience, Shape Your Story
Effective visualization starts with understanding who you're communicating with

4

The Executive (5-minute attention span)
• What they want: Bottom line impact, key trends, 

actionable insights
• Best practices: Lead with conclusions, use big 

numbers and simple comparisons
• Chart choices: Clean bar charts, trend lines, 

executive dashboards
• Avoid: Complex methodologies, detailed 

breakdowns, technical jargon

The Analyst (Detail-oriented)
• What they want: Methodology, data sources, 

statistical significance
• Best practices: Show your work, include confidence 

intervals, provide data tables
• Chart choices: Scatter plots, box plots, detailed 

multi-series charts
• Avoid: Oversimplified summaries, hiding uncertainty

The General Public (Diverse backgrounds)
• What they want: Clear takeaways, relatable context, 

engaging stories
• Best practices: Use familiar references, progressive 

disclosure, clear annotations
• Chart choices: Simple comparisons, infographics, 

interactive elements
• Avoid: Technical terms, assumption of statistical 

literacy

The Technical Team (Implementation focus)
• What they want: Specifications, processes, 

operational metrics
• Best practices: Show workflows, highlight 

bottlenecks, include benchmarks
• Chart choices: Process flows, performance 

dashboards, diagnostic charts
• Avoid: High-level summaries without operational 

details
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Data Structure Matters

5

✓ Consistent

General
Examples 

Excel 

Python

R

TEXT() to standardize dates: 
=TEXT(A1,"MM/DD/YYYY")
SUBSTITUTE() to standardize names: 
=SUBSTITUTE(A1,"HR","Human 
Resources")

Same formats, naming conventions, 
time periods. Example: 01/02/2025 
not a mix of "Jan 2025", "Human 
Resources" vs. "HR"

pd.to_datetime(df['date'], 
format='%m/%d/%Y') to standardize 
dates

str_replace_all(department, 
"HR", "Human Resources") to 
clean text

Pandas, Numpy, 
Scipy

Dplyr, tidyr, 
stringr
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Data Structure Matters
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✓ Consistent ✓ Complete

General
Examples 

Excel 

Python

R

TEXT() to standardize dates: 
=TEXT(A1,"MM/DD/YYYY")
SUBSTITUTE() to standardize names: 
=SUBSTITUTE(A1,"HR","Human 
Resources")

Same formats, naming conventions, 
time periods. Example: 01/02/2025 
not a mix of "Jan 2025", "Human 
Resources" vs. "HR"

pd.to_datetime(df['date'], 
format='%m/%d/%Y') to standardize 
dates

str_replace_all(department, 
"HR", "Human Resources") to 
clean text

No missing values that could 
mislead.  Example: Show "0" or "No 
Data" rather than blank cells Excel 
might skip

IF(ISBLANK(A1),"No Data",A1) 
to replace blank cells that 
Excel might skip

df['compliance_rate'].fillna('No 
Data') instead of leaving NaN 
values

replace_na(compliance_data, 
list(score = "No Data"))

Pandas, Numpy, 
Scipy

Dplyr, tidyr, 
stringr
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Data Structure Matters
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✓ Consistent ✓ Complete ✓ Validated

General
Examples 

Excel 

Python

R

TEXT() to standardize dates: 
=TEXT(A1,"MM/DD/YYYY")
SUBSTITUTE() to standardize names: 
=SUBSTITUTE(A1,"HR","Human 
Resources")

Same formats, naming conventions, 
time periods. Example: 01/02/2025 
not a mix of "Jan 2025", "Human 
Resources" vs. "HR"

pd.to_datetime(df['date'], 
format='%m/%d/%Y') to standardize 
dates

str_replace_all(department, 
"HR", "Human Resources") to 
clean text

No missing values that could 
mislead.  Example: Show "0" or "No 
Data" rather than blank cells Excel 
might skip

IF(ISBLANK(A1),"No Data",A1) 
to replace blank cells that 
Excel might skip

df['compliance_rate'].fillna('No 
Data') instead of leaving NaN 
values

replace_na(compliance_data, 
list(score = "No Data"))

Cross-checked against source 
systems. Example: Use 
dropdown lists for consistent 
entry (High/Medium/Low risk 
levels)

Data → Data Validation → List → 
Source: High,Medium,Low for 
dropdown controls

pd.Categorical(df['risk_level'], 
categories=['Low', 'Medium', 
'High'])

factor(risk_level, levels = 
c("Low", "Medium", "High"), 
ordered = TRUE)

Pandas, Numpy, 
Scipy

Dplyr, tidyr, 
stringr
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Data Structure Matters
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✓ Consistent ✓ Complete ✓ Validated ✓ Documented

General
Examples 

Excel 

Python

R

TEXT() to standardize dates: 
=TEXT(A1,"MM/DD/YYYY")
SUBSTITUTE() to standardize names: 
=SUBSTITUTE(A1,"HR","Human 
Resources")

Same formats, naming conventions, 
time periods. Example: 01/02/2025 
not a mix of "Jan 2025", "Human 
Resources" vs. "HR"

pd.to_datetime(df['date'], 
format='%m/%d/%Y') to standardize 
dates

str_replace_all(department, 
"HR", "Human Resources") to 
clean text

No missing values that could 
mislead.  Example: Show "0" or "No 
Data" rather than blank cells Excel 
might skip

IF(ISBLANK(A1),"No Data",A1) 
to replace blank cells that 
Excel might skip

df['compliance_rate'].fillna('No 
Data') instead of leaving NaN 
values

replace_na(compliance_data, 
list(score = "No Data"))

Cross-checked against source 
systems. Example: Use 
dropdown lists for consistent 
entry (High/Medium/Low risk 
levels)

Data → Data Validation → List → 
Source: High,Medium,Low for 
dropdown controls

pd.Categorical(df['risk_level'], 
categories=['Low', 'Medium', 
'High'])

factor(risk_level, levels = 
c("Low", "Medium", "High"), 
ordered = TRUE)

Clear definitions of what each 
metric means
Example: "Compliance Rate" = 
(Passed Audits / Total Audits) × 
100

Insert → Comment or create 
"Notes" tab with formulas like 
=B2/C2*100

df.attrs['compliance_rate'] = 
'Passed Audits / Total Audits * 
100'

attr(df$compliance_rate, 
"label") <- "Passed Audits / 
Total Audits * 100"

Pandas, Numpy, 
Scipy

Dplyr, tidyr, 
stringr
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Power Query: Your Data Cleaning Superhero
Excel's built-in tool for cleaning and transforming data without changing your source files

10

Why use Power Query: 
• Works on copies - never changes source 

files 
• Reusable recipes - save and replay 

cleaning steps 
• One-click refresh - auto-updates with 

new data 
• Team sharing - export/import processes 
• Multi-source - combine different folders 
• Step-by-step undo - see before/after 
• Error handling - skips bad rows 

How to find Power Query: 
In Excel’s data ribbon, click on Data → Get Data

1

2

3

4

1. Ribbon - tabs for transform and query options 

2. Queries pane - view all available queries 

3. Current view - data preview (main working area) 

4. Query settings - query name, steps, and indicators 

Image: The Power Query 
user interface. Available at: 
https://learn.microsoft.com/
en-us/power-query/power-
query-ui

https://learn.microsoft.com/en-us/power-query/power-query-ui
https://learn.microsoft.com/en-us/power-query/power-query-ui
https://learn.microsoft.com/en-us/power-query/power-query-ui


Understanding Human 
Perception 
How our brains decode visual information

The eye and the visual cortex of 
the brain form a remarkably 
sophisticated image processing 
system.

Colin Ware
Information Visualization Expert
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Types of data
Qualitative: data whose values describe some characteristic or category

Nominal: examples are nouns, with no order to them, such as:
• Country, 

• Gender, 

• Race, 

• Hair color

• Zip Codes

Ordinal: examples come with a level of order, such as
• Level of customer experience (good, neutral, bad), 

• Socioeconomic status (low, middle, high), 

• Education level (high school, BS, MS, PHD), 

• Income level (less than 50K, 50K-100K, over 100K)

• Motion picture ratings(G, PG, PG-13, R)

Quantitative: data that take on numerical values

Discrete: countable measurements such as: 
• Results from the roll of dice, 

• Typing speed per minute, 

• Goals in a soccer game, 

• Number of books in a library

Continuous: represents intervals such as weight, height, blood sugar levels

12

Category

Quantity
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Visual Cues

13

Category Quantity Text
1. Position Position Size

2. Color: Hue Length Color: Hue

3. Shape Angle Color: Intensity

4. Texture Size Space

5. [none] Color: Intensity Styling (italics)

More accurate

Less accurate
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Visual Cue: Position

Category Quantity
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Visual Cue: Position with enclosures

Category Quantity
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Visual Cue: Color

Category Category or Quantity

different 
hues

intensity intensity & 
different hues
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Visual Cue: Color

17

Category Category or Quantity

QuantityCategory

0 1000-10 11-20 21-30 31-40 41-5051-60
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Visual Cue: Color

18

Text

Lorem Ipsum is simply dummy text of the printing and typesetting 
industry. Lorem Ipsum has been the industry's standard dummy text 
ever since the 1500s, when an unknown printer took a galley of type 
and scrambled it to make a type specimen book. It has survived not 
only five centuries, but also the leap into electronic typesetting, 
remaining essentially unchanged. It was popularized in the 1960s 
with the release of Letraset sheets containing Lorem Ipsum 
passages, and more recently with desktop publishing software like 
Aldus PageMaker including versions of Lorem Ipsum
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Visual Cue: Shape

19

Category
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Visual Cue: Texture

20

Category
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Visual Cue: Length or Height

Quantity
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Visual Cue: Length or Height with baselines

average

Quantity
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Visual Cue: Angle

Quantity Quantity
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Visual Cue: Angle

24

Quantity Quantity
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Visual Cue: Size

Quantity Quantity
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Visual Cue: Size, Spacing, Styling for Text
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Text
Lorem Ipsum is simply dummy text of the printing and typesetting industry. 
Lorem Ipsum has been the industry's standard dummy text ever since the 
1500s, when an unknown printer took a galley of type and scrambled it to make 
a type specimen book. 

It has survived not only five centuries, but also 
the leap into electronic typesetting, remaining 
essentially unchanged. 

It was popularized in the 1960s with the release of Letraset sheets containing 
Lorem Ipsum passages, and more recently with desktop publishing software 
like Aldus PageMaker including versions of Lorem Ipsum



Leading the way to better careLeading the way to better careNorthwestern University Feinberg School of Medicine

Chart Chooser

Juice Analytics Chart Chooser: http://labs.juiceanalytics.com/chartchooser/index.html

Data Visualization Catalog: https://datavizcatalogue.com/

http://labs.juiceanalytics.com/chartchooser/index.html
https://datavizcatalogue.com/
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Sketching Visualizations

28



Chart Encyclopedia
Choosing the right visualization for your story

The greatest value of a picture 
is when it forces us to notice 
what we never expected to see.

John Tukey
Statistician
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Bar Charts

30

Shows change in a single data type over time. Perfect for tracking 
trends in instruction sessions across multiple years.

Displays multiple related data types within a single bar. Ideal for showing Fall 
and Spring sessions together while maintaining visibility of the total.

Places related bars side-by-side for direct comparison. Best when 
comparing Fall vs. Spring sessions across multiple years.

Converts data to percentages (out of 100%), highlighting proportional 
relationships rather than absolute values.

Bar Chart 

Stacked Bar Chart

100% Stacked Bar Chart

Clustered Bar Chart
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Bar Charts continued

31

100% Stacked Bar Chart
Show change in more than one related data type over time as 
percent of 100. 

A common use for a 100% Stacked Bar Chart is to show survey 
responses from a Likert Questions where the categories show 
positive, neutral, or negative responses. 
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Column Charts

32

Column Chart 
Used to compare values across one or more categories. Now showing count of 
reference questions answered each year from 2016-2020

Stacked Column Chart
Used to compare parts of a whole. Use to show how segments  of a whole change 
over time. Now showing Count of reference questions answered in Fall and Spring 
each year from 2016-2020. 

100% Stacked Column Chart
Used to compare percentage that each value contributes to the total. Use to show how 
the percentage of each value contributes changes over time. Now showing Percent of 
reference questions answered in Fall and Spring each year from 2016-2020. 

Clustered Column Chart
Used to compare values across a few categories. Use when order of categories is 
not important. Now showing comparison of reference questions answered in Fall 
and Spring each year from 2016-2020.
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Column Charts continued

33

Overlapping Column Chart 
Used for comparing one set of columns to an underlying or 
nested set of columns
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Line Charts

34

Line Chart
Use line charts to show trends over time (years, months, days) or when the 
sequence of categories is important. Ideal for displaying continuous data 
with many points.
Example: Unique library website page views each year from 2014 to 2018.

Multiple Line Chart
Use when comparing trends across two or more groups over time or 
across ordered categories. Each line represents a different group, making 
it easy to see patterns, similarities, and differences in how values change.
Example: Comparing unique page views for Fall and Spring on the library 
website from 2014 to 2018.

Stacked Area Chart
Use stacked area charts to show how parts contribute to a whole over time or 
across ordered categories. Great for highlighting both individual category 
trends and the overall total.
Example: Unique library website page views from Fall to Spring, 2014–2018.
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Combining Chart Types

Combo Chart (Bar + Line)

Used when you want to show two types of information on the 
same chart—often with different scales or units.
Use the bars to display quantities (e.g., total visitors) and the 
line to show a trend or rate (e.g., bounce rate or percentage 
change). Great for showing how one variable relates to another 
over time or categories.

Example: Total number of library visitors to the library website 
by year (bars) compared with average session duration (line) 
from 2018–2022.

35
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Pie and Donut Charts

36

Pie Chart
Used to show proportions of a whole. Use to show numbers that related to a larger 
sum and always equal 100%. Do not use this chart if it contains many slices as 
angles are hard to estimate. Now showing type of viewers of PMC in 2012. 

Donut Chart
Like a pie chart, a doughnut chart shows the relationship of parts to a whole, but 
a doughnut chart can contain more than one data series. Each data series that 
you plot in a doughnut chart adds a ring to the chart. But if you want to compare 
the data points side by side, you should use a stacked column or stacked bar 
chart instead. Now showing category of clinical questions answered in 2018. 
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Scatter Plot and Bubble Charts

37

Scatter Plot
Used to plot numerical data on both the x and y axis. Use when you have two variables 
that pair well together. Now showing the number of documents published and the 
average citation impact scores of those documents for several universities. 

Bubble Chart
Similar to a scatter plot but allows for a third variable to be charted as the size of 
the bubble. Now showing the average percentile rank of documents vs. the 
average normalized category impact of documents, with bubbles sized by the 
number of documents published. 
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Histogram and Slope Chart

38

Histograms
Used to group data into ranges. Tall bars show that more data falls into that 
range. Now showing minutes needed to answer the questions of medical 
residents. There were 17 questions that took between 2 and 12 minutes to 
answer. 

Slope Chart
Used to show developments between two points, e.g. between two 
dates. Now showing the increase in number of user sessions before and 
after a promotional news item about the database. 
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Sunburst and Tree Map

39

Sunburst
Used to display a hierarchical structure data in circular form. Just like a 
doughnut chart, Sunburst Chart is also used to display a part of the whole 
data and compare relative sizes. But it can also show the relationships in the 
hierarchy. Now showing Topic Areas (macro, meso, micro) of publications by 
Public Health Department from 2018 -2020. 

Tree Map
Used to display a hierarchical view of data and makes it easy to spot 
patterns. The tree map chart displays categories by color and proximity and 
can easily show lots of data which would be difficult with other chart types. 
Now showing MeSH terms for Public Health Documents in 2018
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Big Number and Sankey

40

Sankey Diagram
Sankey diagrams emphasize the major transfers or flows 
within a system. They help locate the most important 
contributions to a flow. Now showing faculty expertise in 
various clinical research areas. 

Big Number
The "Big Number" is about emphasizing the magnitude of a 
number. You can use a Text Box and Font Size and Color to 
create a "Big Number". 
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Venn Diagram and Choropleth Map

41

Venn Diagram
Uses overlapping circles to illustrate the 
similarities, differences, and relationships 
between concepts, ideas, categories, or groups.

Choropleth Map
Displays divided geographical areas or regions that are colored, 
shaded or patterned in relation to a data variable. This provides a 
way to visualize values over a geographical area, which can show 
variation or patterns across the displayed location.
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Gauge Chart and Heat Map

42

Gauge Charts

Defies rules for good data visualization but 
provide a big visual to balance out text for 
qualitative data. Now showing average 
satisfaction rate for repository services. 

Heat Map

Graphical representation of data showing 
relationship between two values using color. Now 
showing themes from interviews about repository 
use. 

NeutralNeutral

Researchers Students

18% 

avg satisfaction rate
79% 

avg satisfaction rate
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Timelines and Journey Map

43

Timeline

Displays list of events in chronological order, often in a 
story format. Now showing the history of scholarly 
communication. 

Journey Map

Shows how a person moves through an experience with 
your organization, and can highlight areas of strength and 
weakness. Now showing the average rating of user 
experience with library classes and services. 
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Histomaps and Call Out Boxes

44

Histomaps/Stream Maps

Display qualitative data over time. Similar to stacked area 
graphs. Now showing mentions of major themes from staff 
survey over 5-year period. 

Call Out Boxes/Quotes

Display quotes that emphasize important data. Now 
showing quotes from the 2019 Library Staff Survey. 
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“We need to focus more on 
improving our project 
management skills so that 
we make better use of 
everyone’s time.”

“I want to improve my skills 
but don’t feel like my 
manager is supportive of 
me.”

“I enjoy all of the 
opportunities I have to 
collaborate with others in the 
library. “

Library Staff Survey 2019
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Word Cloud and Network Map

45

Word Cloud

Displays how frequently words appear in a body of text, by 
making the size of each word proportional to its frequency. 
Now showing keywords from documents from a search on 
democracy. 

Network Map

Displays relationships between entities. Entities are displayed 
as round nodes and lines (also called edges) show the 
relationships between them. Now showing relationships 
between journals publishing economics themed articles. 
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Tables

• Title indicating purpose and content

• Emphasis on relationships within the data

• At least 3 columns

• Clear headings

• No blank cells

• Limited decimals (up to 2)

• Decimal alignment

• Careful use of footnotes

• Indication of the number of cases in the table (n=)
•     (Wallace& Van Fleet, 2012)

46
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Resources 

Basic and Advanced Excel: 

• Gutzman, K. E., Mendoza, A. R., Norton, C., Belter, C., & Soulakis, M. (2024). Charting a New Course Excel Workbook 
(v9.0.0). DigitalHub. Galter Health Sciences Library & Learning Center. https://doi.org/10.18131/1nan8-mzk41

Practice data and examples of charts

• Gutzman, K. E., Mendoza, A. R., Norton, C., & Belter, C. (2021). Hands On Creating Basic Charts (v3.0.0).DigitalHub. 
Galter Health Sciences Library & Learning Center. https://doi.org/10.18131/g3-69ds-eq61

47

https://doi.org/10.18131/1nan8-mzk41
https://doi.org/10.18131/g3-69ds-eq61


Designing Information 
Experiences
Using charts, graphs, and visuals to tell compelling 
stories with your data

Clutter and confusion are 
failures of design, not 
attributes of information.

Edward Tufte
Statistician and Professor
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Lead with Meaning

49

Inspired by  Stephanie Evergreen So What? Available at: https://stephanieevergreen.com/so-what/

Attendees scores increase by 72% on average from

pre-test to post-test in our databases information sessions. 

Our teaching is effective. 
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Use Call-Out boxes & Side Bars
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Inspired by Stephanie Evergreen. Sidebars are Your Friend. Available at: https://stephanieevergreen.com/sidebars-are-your-friend/
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Use Informative Labels and Legends
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Inspired by Stephanie Evergreen. Use Labels Sparingly. Available at: https://stephanieevergreen.com/labels-are-used-sparingly/
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Empty Space Isn’t Wasted Space

52
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Colors Should Guide, Not Overwhelm

53
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Try different kinds of charts

54

Inspired by Stephanie Evergreen. You Just Need More Chart Choices. Available at: https://stephanieevergreen.com/you-just-need-more-chart-choices/

https://stephanieevergreen.com/you-just-need-more-chart-choices/
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Transform Raw Numbers into Actionable Insights

55

When Raw Numbers Feel Abstract

• Convert to percentages or ratios - 
"45% market share" vs. "450,000 
customers"

• Show change over time instead of 
snapshots - "Sales up 15%" vs. "Sales 
= $2.3M"

• Use familiar units - "$12 per day" vs. 
"$4,380 per year"

When Comparisons Are Difficult

• Create rankings or categories - "Top 
performer" vs. "scored 847 points"

• Show relative to benchmark - "20% 
above average" vs. "3.2 rating"

• Normalize by population - "5 per 
1,000 residents" vs. "500 total cases"

When Precision Overwhelms

• Round to meaningful digits - 
"About $50K" vs. "$49,847.23"

• Group into categories - 
"High/Medium/Low risk" vs. "Risk 
scores 1-100"

• Focus on top performers + "other" 
- "Show top 5 + Other" vs. "Show all 
47 items"
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Example of Transforming Numbers

56

Source: Brenner, H. (2002). Long-term survival rates of 
cancer patients achieved by the end of the 20th century: a 

period analysis. The Lancet, 360, pp. 1131-1135.
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Example of Transforming Numbers

57

Insights: 
• Success stories. Prostate and thyroid 

cancers stand out with exceptional 
survival rates - prostate at 98.8% at 5 
years and thyroid at 96%. 

• The Pancreatic Challenge.  Pancreas 
cancer shows devastatingly low survival 
rates (4% at 5 years, dropping to 2.7% at 
20 years), highlighting one of oncology's 
most urgent challenges.

• Brain Cancers.  Show consistently low 
survival rates (32% at 5 years), 
highlighting the challenges of treating 
central nervous system malignancies.

From Diagnosis to 20 Years Later: 
How Cancer Survival Rankings Evolve

5 
years

10 
years

15 
years

20 
years

Source: Brenner, H. (2002). 
Long-term survival rates of 
cancer patients achieved by 
the end of the 20th century: a 
period analysis. The Lancet, 
360, pp. 1131-1135.
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Present One Big Idea at a Time
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Focus on Insights:
• Every visualization should answer one 

primary question or make one key point. 
• Your goal isn't to show all your data, it's to 

communicate insights that drive action.

Strategies include: 
• Use multiple simple charts instead of one 

complex chart.
• Gray out supporting data. Keep context but 

don't let it compete for attention.

See: https://www.pewresearch.org/global/2025/07/08/people-in-
many-countries-consider-the-u-s-an-important-ally-others-see-it-
as-a-top-threat/pg_2025-07-08_allies-threats_0_03/

https://www.pewresearch.org/global/2025/07/08/people-in-many-countries-consider-the-u-s-an-important-ally-others-see-it-as-a-top-threat/pg_2025-07-08_allies-threats_0_03/
https://www.pewresearch.org/global/2025/07/08/people-in-many-countries-consider-the-u-s-an-important-ally-others-see-it-as-a-top-threat/pg_2025-07-08_allies-threats_0_03/
https://www.pewresearch.org/global/2025/07/08/people-in-many-countries-consider-the-u-s-an-important-ally-others-see-it-as-a-top-threat/pg_2025-07-08_allies-threats_0_03/
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United States is perceived as the greatest threat for 8 countries

Russia is perceived as the greatest threat for 11 countries

China is perceived as the greatest threat for 3 countries

US, China, 
Russia seen as 
top threats 
across multiple 
countries

2025 Pew Research Center

% who say _______ is their 
country’s greatest threat.  

The U.S. is seen as a threat 
that spans diverse regions 
and are not limited to 
adversaries but includes 
allies and neutral countries 
as well.

Russia is seen as a 
threat with regional 
concentration, 
suggesting influence 
related to proximity, 
conflict history, and 
energy ties.

China is seen as a 
strategic rival in both the 
Indo-Pacific and the U.S., 
aligning with tensions over 
trade, military buildup, 
and regional influence.

InsightsThreats Patterns

Not shown: Regional rivalries and internal 
tensions often eclipse global powers in 
perceived threat assessments. For 
example,  Turkey (74%) is seen as the top 
threat by its own citizens, reflecting 
internal divisions. South Korea names 
Pakistan. Iran, North Korea, and Israel also 
appear in regional contexts.
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Data Visualization Checklist

60

Source: Evergreen, Stephanie, Data Visualization Checklist. Available at: 
https://stephanieevergreen.com/wp-content/uploads/2020/12/EvergreenDataVizChecklist.pdf



Ethics in Data 
Visualization
Responsibility, Truth, and Trust in Visual Communication

The responsibility of an ethical 
data visualizer is to create the 
most good while doing the 
least harm.

Alberto Cairo
Visual Journalist 
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The Ethics of Data Visualization
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“I shall not use visualization to intentionally hide or confuse the truth which it is 

intended to portray. I will respect the great power visualization has in garnering 

wisdom and misleading the uninformed. I accept this responsibility willfully and 

without reservation, and promise to defend this oath against all enemies, both 

domestic and foreign.”

- Jason Moore of the Air Force Research Lab as quoted 

during a presentation at the 2011 VisWeek conference
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Manipulating an axis
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Omitting the baseline
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Cherry Picking the Data
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Using nonsensical representation
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Going against convention
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Make Spurious Correlations

68



Tools of the Trade
From Excel to advanced platforms
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Visualization Software
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Advantages Challenges Support

Excel • High familiarity, 
• Compatible w/ Microsoft 

products,
• Easy to edit/analyze 

underlying data

• No report portal
• VBA & Macros have low 

familiarity
• May need add-ons for some 

chart types

• How to Build Data Visualizations 
in Excel: 
https://stephanieevergreen.com
/how-to/

Google Charts • Free
• Interactive charts 
• Compatible with Google 

Sheets

• Some familiarity with 
JavaScript

• Difficult to edit or analyze 
underlying data

• Google Charts: 
https://developers.google.com
/chart

Python or R • Free
• Highly customizable charts
• Powerful data analysis tool
• Interactive charts

• Requires familiarity with the 
language

• Ability to access Jupyter Lab or 
R Studio

• JupyterLab: https://jupyter.org/
• R Studio: 

https://www.rstudio.com/

Tableau • Customizable and 
interactive charts

• Integrates with Python or R

• Only Tableau Public is free 
making your underlying data 
and visualizations open to the 
public

• Tableau Public Support:
https://www.tableau.com/sup
port/public

https://stephanieevergreen.com/how-to/
https://stephanieevergreen.com/how-to/
https://developers.google.com/chart
https://developers.google.com/chart
https://jupyter.org/
https://www.rstudio.com/
https://www.tableau.com/support/public
https://www.tableau.com/support/public
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The Excel Reality Check
Understanding the strengths and limitations for data visualization
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Strengths Limitations

Strengths to Leverage
• Ubiquitous across organizations
• Built-in chart types for common needs
• Real-time chart updates from data changes

Limitations to Work Around
• Limited advanced formatting options
• Difficult to create complex visualizations
• Version control challenges
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Excel Macros: Automate Your Repetitive Tasks

What are Macros?
Recorded sequences of actions that Excel can replay automatically - like having a robot perform your repetitive tasks

72

Chart Creation & Styling
Build standard compliance dashboard charts 
with consistent colors, fonts, and layout 

Multi-Sheet Report Generation Create 
pivot tables → Generate charts → Format 
consistently → Compile summary 

Monthly Report Formatting 
Format headers → Apply conditional formatting → 
Create charts → Apply branding

Data Validation Setup 
Create dropdown lists → Set validation rules → Apply 
protection settings. Apply same rules across all 
department reports.

Data Import Cleanup
Remove blank rows → Standardize formats → Apply 
validation → Create summary

Common Use Cases More Advanced Workflows
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How to Get Started with Excel Macros

Recording Your First Macro
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 What Macros Can't Do
• Think or make decisions (just replay exact steps)
• Handle varying data layouts well
• Work across different file structures easily

6

5

4

3

2

1
Enable Developer Tab: 
File → Options → Customize Ribbon → 
Check "Developer"

Click Developer Tab → Record Macro

Give it a descriptive 
name: FormatMonthlyReport

Perform your tasks (Excel watches and 
remembers everything)

Run anytime with a button or keyboard 
shortcut

Click "Stop Recording" when 
finished

 Security & Saving
• Save as .xlsm (macro-enabled) to keep macros
• Enable macros via yellow security bar for trusted files
• Only run macros from trusted sources

 For complex data transformation, use 
Power Query instead
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“Vibe Coding” for Excel
Let AI write your VBA code - no programming experience required!
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Step 1: Get Your Macro
1. Open Claude.ai or ChatGPT
2. Create free account if needed
3. Copy and paste this exact 

prompt:

Create an Excel VBA macro that formats charts 
with Northwestern University brand colors. The 
macro should check if charts exist, format the 
first chart found, and apply these specific colors 
to data series in order: Series 1: RGB(72, 36, 
118), Series 2: RGB(0, 134, 86), Series 3: RGB(13, 
45, 108), Series 4: RGB(255, 197, 32), Series 5: 
RGB(80, 145, 205). Also format the title with 
Northwestern purple, remove gridlines, and 
include error handling.
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“Vibe Coding” for Excel
Let AI write your VBA code - no programming experience required!
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Step 1: Get Your Macro
1. Open Claude.ai or ChatGPT
2. Create free account if needed
3. Copy and paste this exact 

prompt:

Create an Excel VBA macro that formats charts 
with Northwestern University brand colors. The 
macro should check if charts exist, format the 
first chart found, and apply these specific colors 
to data series in order: Series 1: RGB(72, 36, 
118), Series 2: RGB(0, 134, 86), Series 3: RGB(13, 
45, 108), Series 4: RGB(255, 197, 32), Series 5: 
RGB(80, 145, 205). Also format the title with 
Northwestern purple, remove gridlines, and 
include error handling.

Step 2: Create Chart
1. Open Excel, create new 

workbook and save as .xlsm 
2. Copy this data into cells 

A1:F5:

Quarter,Enrollment,Revenue,Research,Sati
sfaction,Alumni 
Q1,15420,28.5,12.3,8.2,5.1 
Q2,16890,31.2,14.7,8.7,5.8 
Q3,17250,33.8,15.9,9.1,6.2 
Q4,18100,35.4,17.2,9.4,6.7

3. Select all data (A1:F5)
4. Insert → Charts → Line Chart
5. Add chart 

title: "Northwestern Metrics"
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“Vibe Coding” for Excel
Let AI write your VBA code - no programming experience required!
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Step 1: Get Your Macro
1. Open Claude.ai or ChatGPT
2. Create free account if needed
3. Copy and paste this exact 

prompt:

Create an Excel VBA macro that formats charts 
with Northwestern University brand colors. The 
macro should check if charts exist, format the 
first chart found, and apply these specific colors 
to data series in order: Series 1: RGB(72, 36, 
118), Series 2: RGB(0, 134, 86), Series 3: RGB(13, 
45, 108), Series 4: RGB(255, 197, 32), Series 5: 
RGB(80, 145, 205). Also format the title with 
Northwestern purple, remove gridlines, and 
include error handling.

Step 2: Create Chart
1. Open Excel, create new 

workbook and save as .xlsm 
2. Copy this data into cells 

A1:F5:

Quarter,Enrollment,Revenue,Research,Sati
sfaction,Alumni 
Q1,15420,28.5,12.3,8.2,5.1 
Q2,16890,31.2,14.7,8.7,5.8 
Q3,17250,33.8,15.9,9.1,6.2 
Q4,18100,35.4,17.2,9.4,6.7

3. Select all data (A1:F5)
4. Insert → Charts → Line Chart
5. Add chart 

title: "Northwestern Metrics"

Step 3: Run the Macro
1. Press Alt + F11 (opens VBA editor)
2. Insert → Module
3. Paste the AI-generated code
4. Press F5 to run macro
5. Return to Excel (Alt + F11)
6. Watch your chart transform! 

 If macro doesn't work, enable 
macros in Excel security settings or save 
as .xlsm file



From Principles to 
Practice 
Building your data visualization expertise

A journey of a thousand miles 
begins with a single step. 

Lao Tzu
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Action Items
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Next 30 days: 

Focus on data structure. Clean up one recurring report using 
the principles we discussed. Create templates for consistent 
formatting.

Next 60 days: 

Experiment with three new chart types from our encyclopedia. 
Replace at least one table with a visualization.

Next 90 days: 

Apply the design principles to redesign your most important 
dashboard or report. 
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Tools and Resources

• "Resonate" by Nancy Duarte - Audience-focused presentation structure

• Stephanie Evergreen's Blog (stephanieevergreen.com) - Data visualization excellence

79
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Share! Upload Reports to a Repository
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•Creates a permanent link (DOI).

•Content is findable by search engines such as Google. Note: The content is a 
permanent deposit into the 
repository. All authors listed 
on poster or presentation 
should provided their 
approval.



Questions and Comments 



Thank you
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